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Windows XP Embedded User’s Guide for 
Eaton XP-702 with Visual Designer

When enabled, Protect Mode actively protects 
your XP-702 unit from unwanted change. As 
changes are made to data and files they appear 
to be saved but in reality they are saved in volatile 
memory. This means that when the XP-702 is 
restarted, all of the changes will be deleted from 
memory and the last information saved in the  
C:\ partition will be used. With this in mind,  
all changes made that are to be stored in the  
C:\ partition must be saved or committed so that 
the next time the XP-702 is restarted the new  
data will be available. Types of data stored on the 
C:\ partition include the XP-702 Runtime software 
and communications drivers, time/date data, 
Ethernet port settings, and all Windows registry 
settings and operating system functionality.

Notes:

•	 The D:\ drive is reserved for user data and is not 
protected by the Protect Mode feature. Data 
and program files can be easily added, modified 
and deleted in this storage area. 

•	 If extensive changes are made to the C:\ parti-
tion without a subsequent reset or execution of 
a Protect Mode Save operation, volatile memo-
ry may become full resulting in system errors.

Protect Mode Save Operation 
While the Eaton XP-702 unit’s Protect Mode is 
active, the unit is protected against any changes 
to data stored on the C:\ partition. In order to 
save desired data changes to the C:\ partition, the 
Protect Mode Save operation must be run. 

It is good practice to shutdown and re-start the 
XP-702 in preparation to making permanent chang-
es to the C:\ partition. This step will ensure that all 
data stored in volatile memory is cleared so that 
no unexpected corruption or changes will take 
place on your C:\ drive. Once the XP-702 has been 
restarted, make your changes and then save the 
changes by selecting Start>All Programs>Protect 
Mode Manager. From the Protect Mode Manager 
window select the Protect Mode Save tab and 
click on the “Commit” button.

Once the Protect Mode Save operation has been 
launched, the changes that affect the C:\ drive will 
be saved and then the XP-702 unit will automati-
cally shutdown and restart, back in Protect Mode.

Introduction 
The Eaton® XP-702 family is made up of high 
performance yet cost-effective operator interface 
(OI) products. The XP-702 family carries on Eaton’s 
operator interface tradition of performance in bal-
ance with ease of use. The XP-702 family sets the 
standard for hybrid OI systems by combining the 
flexibility of Microsoft’s® Windows® 2009 Standard 
Embedded (XP based) operating system with 
the stability and reliability achieved through the 
solid-state hardware design and exclusive Protect 
Mode™ that provides protection for the operating 
system and software. 

The XP-702 family provides the performance and 
flexibility of PC based operator interfaces without 
the associated complexity of a PC on the plant 
floor. With integrated high-speed Ethernet ports, 
serial ports, USB ports, removable CompactFlash, 
and PCI, the XP-702 models can be adapted for a 
wide variety of user requirements. 

The XP-702 family of products configured with 
the Visual Designer® software provides a range of 
solutions ranging from basic operator monitor and 
control functions to full SCADA software capabili-
ties and built-in Web Serving. 

Whether replacing hard-wired pilot devices and 
pushbuttons or providing machine control and high 
end SCADA functions, the XP-702 will suit a wide 
range of user requirements.

The remainder of this document describes some 
of the operating system features of the XP-702 
system.

Protect Mode
The Eaton XP-702 family of products has a  
unique and exclusive Protect Mode feature that 
safeguards the integrity of files stored on the  
C:\ partition of your operating system. This feature 
ensures that data and operating system files can-
not be modified by anyone or corrupted by unex-
pected power disruptions. As a result, you can 
be confident that the XP-702 meets your rigorous 
industrial environmental requirements and can be 
protected against all unauthorized alterations. 
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Disabling Protect Mode
It is possible for the user to disable the Protect Mode feature of the 
XP-702. Reasons for doing so include the need to install a software 
program that is very large or one that requires multiple reboots to 
complete its installation. To do so, open Protect Mode Manager by 
selecting Start>All Programs>Protect Mode Manager. From the 
Protect Mode Manager window select the Advanced tab and click 
on the “Disable Protect Mode Save” button. The system will then 
reboot and flush any pending changes to the protected C:\ partition. 
Upon reboot Protect Mode will be disabled and while in this mode 
the XP unit will behave like any other Windows PC, meaning that it 
is subject to all forms of malware including viruses, and adware and 
it must be shut down through the normal Windows shutdown mech-
anisms to prevent potential corruption of the operating system.

It is recommended that the XP unit be removed from any plant net-
work while Protect Mode is disabled and that all media connected 
to the unit for software installation are scanned for malware prior to 
attaching it to the unit. Once all desired changes have been made 
the user should place the XP unit back in Protect Mode through the 
Advanced tab of the Protect Mode Manager utility by clicking on 
the “Enable Protect Mode Save” button. This will force a reboot and 
return the XP unit to its protected state.

Downloading the Visual Designer Project
Setting the XP-702’s IP Address

To download the Visual Designer project to the XP-702 over Ethernet 
you will first need to establish an Ethernet connection to the XP-702 
unit. This can be done many ways from a simple point-to-point con-
nection with a Cat 5 crossover cable or by using an Ethernet hub,  
switch, or router. Note that some PC’s Ethernet ports will autosense 
the transmit/receive lines and provide internal crossover capabil-
ity. If your PC has this feature you can use a standard Cat5 patch 
cable to connect to the XP-702. The XP-702’s two Ethernet ports 
are configured at the factory for DHCP so that if it is connected to a 
router which provides the DHCP service or to a plant network it will 
automatically be assigned an IP address. In most applications the 
XP-702’s IP address will be set to a static value. If you are unsure of 
how to set the XP-702’s IP address please consult your local IT sup-
port personnel. Once you know what static IP address to assign the 
XP unit take the following steps:

1.	 Open Control Panel with Start > Control Panel, then double  
	 click to open the Network Connections dialog.

2.	 Double-click on one of the Local Area Connection icons and  
	 scroll down in the connection items list to select Internet  
	 Protocol (TCP/IP) and then click on the “Properties” button.

3.	 Select the radio button labeled “Use the following IP Address:”,  
	 then type in the IP address and subnet mask (Eg. 192.168.1.212  
	 and 255.255.255.0) and click “OK”

4.	 Click OK to close the Local Area Connection Properties dialog,  
	 then close the Network Connections window.

Note that there are two Ethernet ports on the XP unit the one physi-
cally located next to the serial Comm2 port is listed as Local Area 
Connection 1 and is the 10/100 BASE-T port. The other is listed as 
Local Area Connection 2 and is the 10/100/1000 BASE-T port. 

Creating a Backup/Restore Point for your XP System

It is strongly recommended that the user backup the XP’s operating 
system as soon as possible after the unit is received, powered up, 
and placed in Protect Mode. This is so that in the unlikely event of 
an unintentional corruption of the operating system, the user will 
be able to recover the unit to its original factory settings, with Visual 
Designer licensing intact. Because the Visual Designer runtime soft-
ware license is unique to each XP unit, it is not possible for Eaton to 
provide an OS restore image that includes the Visual Designer soft-
ware license. To prevent delays and costs that could result from the 
need to recover a unit’s operating system without having a restore 
image that includes the Visual Designer license, Eaton provides a 
backup/restore utility free of charge on our website. It is provided 
in zipped format complete with an Instruction Leaflet (IL) which 
describes the use of this utility. This can be downloaded by going to 
www.eaton.com/oi and then browsing to the OI Software section 
and clicking on the Visual Designer Software icon in the Download 
section of that web page. Once the utility is downloaded the user 
can unzip the utility and use the MKRestore batch file to create a 
bootable USB memory drive with the install utility loaded.

Downloading to the XP-702 via Ethernet

Once you have an Ethernet connection established between your 
development PC and the XP-702 unit, make sure that the Remote 
Agent which opens by default at XP’s startup is running. If it was 
shut down manually you can restart the Remote Agent with Start 
> All Programs > Eaton > Visual Designer vX.Y> Remote Agent. 
Then open your Visual Designer project on your PC and click on the 
Connect button on the Home tab of the Ribbon under the Remote 
Management Group. In the Network IP property type in the  
IP address of the XP-702 as shown below and click on the  
“Connect” button.

If your Ethernet connection is configured correctly the Status  
property will change to show “Connected to Visual Designer vX.Y” 
as shown below.
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Next, click on the “Project” tab on the left side of the Remote 
Management window. Verify that the target is set correctly to  
D:\Cfg\APPL\ . If it is not set correctly, click on the button labeled 
“…” to the right of the target property and select the D drive and 
browse to the Cfg\APPL folder. 

Once the target path is set make sure to uncheck the check-
box “Only newer files” then click the “Download…” button. An 
Execution Environment dialog will display informing you to verify 
that the target platform’s license supports the Product Type config-
ured. If the XP’s license is sufficient to run the project, click on the 
“Yes” button which will begin the download operation. Note that the 
Status: property will update with every file downloaded. After all files 
have been successfully downloaded the Status will indicate “Files 
were sent successfully.”  To start the project on the XP you can 
either click on the “Run” button on the Remote Management dialog 
box on your PC or click on the “Start” button on the Remote Agent 
dialog on the XP.

You should make sure to perform a Protect Mode Save operation 
after you download to the XP-702 in order to permanently save the 
changes to Visual Designer’s Program Settings.ini file on the C:\ 
drive that are made during the download process.

Downloading to the XP-702 USB Memory Device

You may also choose to manually load your Visual Designer project 
from a USB memory device rather than use the Ethernet transfer 
method. To do so you should take the following steps:

1.	 Copy the entire project folder from your development PC to  
	 a USB memory device. Note that by default the project folder  
	 is stored under “My Documents\ Visual Designer vX.Y Projects”  
	 in a folder name matching the project name when it was created.

2.	 Place the USB memory device in a USB port of the XP-702 and  
	 paste everything under the project folder (not including the  
	 project folder) into the D:\Cfg\APPL folder of the XP unit.  
	 (Eg. Alarm, Config, Database, Hst, Screen, Symbol, and Web  
	 folders plus the APPNAME.APP file; plus any user created files  
	 and folders under the project folder)

3.	 Open Visual Designer on the XP-702 Start > All Programs >  
	 Visual Designer vX.Y > Visual Designer vX.Y.

4.	 A Visual Designer error dialog should pop up saying “The Project  
	 was not found in the …”  This is normal, click “OK”

5.	 A Visual Designer warning dialog should then pop us saying  
	 “License not found!”. This is also normal, click “OK”

6.	 The Visual Designer window will then display with no project  
	 selected. Click on the File Open icon on the Quick Launch  
	 toolbar or click the Visual Designer icon in the upper left corner  
	 of the window and select “Open Project” from the drop list.

7.	 Browse to the D:\Cfg\APPL folder of the XP and select the .APP  
	 file located in that folder then click on the button labeled “Open”.

8.	 Another Visual Designer license warning dialog may pop up. If it  
	 does click “OK”

9.	 Once the project loads and shows in the Project Explorer section  
	 you may close the Visual Designer application. This step will  
	 properly configure the Program Settings.ini file on the C:\ drive.

10.	Perform a Protect Mode Save operation. Go to Start > All  
	 Programs > Protect Mode Manager and select the Protect  
	 Mode Save tab and click the “Commit’ button.

Automatically Starting the Visual Designer Project

The Visual Designer project is set to automatically run when the 
XP-702 boots up. If you wish to have the user manually start the 
project you will need to remove the Startup shortcut from the 
Windows startup folder. To do so take the following steps:

1.	 From the XP click Start > All Programs > Windows Explorer

2.	 Browse to the folder “C:\Documents and Settings\All Users\Start  
	 Menu\Programs\Startup” and delete the StartUp shortcut icon  
	 from that folder.

3.	 Close the Windows Explorer window and perform a Protect  
	 Mode Save operation. Start > All Programs > Protect Mode  
	 Manager then select the Protect Mode Save tab and click the  
	 “Commit” button.

After the XP saves the changes to Windows partition it will reboot, 
and automatically launch the Remote Agent but not the Visual 
Designer project. The user can then click on the Start button of the 
Remote agent to manually launch the Visual Designer project.

Updating the Visual Designer Version 
For proper runtime operation, it is critical that the version of Visual 
Designer running on an XP unit match the version of Visual Designer 
used to develop the runtime application. On new XP units the oper-
ating system image may have an older version of Visual Designer 
runtime software than the version currently available from the Eaton 
website. Because some users choose not to update their develop-
ment software to the latest version available, the version of Visual 
Designer runtime software which comes installed on a new unit may 
be newer than the version they are currently using for development. 
For these reasons it is important to follow the recommended proce-
dure for installing the correct version of Visual Designer runtime files 
on an XP unit when the development and runtime versions don’t 
match.

Checking the Current Version of Visual Designer

To check the runtime version on an XP or on your development PC 
you follow the same process.

1.	 Open the Visual Designer editor with Start > All Programs >  
	 Eaton > Visual Designer vX.X > Visual Designer vX.X. 

Starting Visual Designer on XP unit
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2.	 Go to the Help tab on the Ribbon and click on the About icon.

Selecting Help About

Help About Window

3.	 If the runtime version, Service Pack number, Patch number or  
	 Build Number do not agree then you need to install the version  
	 of software that the project was developed in, i.e. the version of  
	 Visual Designer that is running on the development PC.

Updating the Visual Designer Runtime on an XP-702 Unit

1.	 Before beginning the update process you should first disable  
	 Protect Mode on the XP unit. Note: Before disabling Protect  
	 Mode it is strongly recommended that you have a good backup  
	 of the XP’s operating system. If you have not already done so,  
	 refer to the previous section in the document titled “Creating a  
	 Backup/Restore Point for your XP System”. Protect Mode, when  
	 enabled, prevents permanent or unwanted change to the XP’s  
	 Windows operating system. For large changes to the Windows  
	 operating system, such as installing a large new program, the  
	 user has the ability to disable Protect Mode on the XP, and then  
	 after installing the program, to re-enable Protect Mode to insure  
	 operational reliability of the unit. To disable Protect Mode open  
	 XP’s Protect Mode Manager Start > All Programs > Protect  
	 Mode Manager (top of the list). In the Protect Mode Manager  
	 window click the Advanced tab as shown below and click on the  
	 button labeled Disable Protect Mode. This will cause the XP unit  
	 to reboot.

Disabling Protect Mode

2.	 Once the unit has booted up, Protect Mode is no longer active.   
	 Important Note: With Protect Mode disabled the XP unit can  
	 be thought of as a normal Windows Industrial PC but without  
	 Anti-Virus software or the latest Microsoft Security Updates.  
	 Care should be taken to not expose the XP to the risk of Virus  
	 infection by removing it from any network and making sure  
	 any USB memory devices used on the unit while running without  
	 Protect Mode have been scanned for viruses and other malware.  
	 Also, avoid removing power from the unit during installation or  
	 removal of software as this may result in a corrupted File  
	 Allocation System. All reboots should be done through the  
	 Windows shutdown options.

3.	 Now with Protect Mode disabled, uninstall the current version  
	 of Visual Designer by opening Control Panel and selecting Add  
	 or Remove Programs.

Add or Remove Programs

4.	 In the Add Remove Programs dialog select the Visual  
	 Designer vX.X and click on the Remove button.

Uninstall Visual Designer

5.	 You will get an error dialog as shown below indicating no  
	 Windows Installer can be found. Click the OK button.

Error Dialog

6.	 You will next get a confirmation dialog asking you “Do you want  
	 to completely remove the selected application and all of its  
	 features?”. Click the Yes button.

7.	 Windows will begin uninstalling Visual Designer. When complete  
	 a Window stating that the uninstall process is complete will be  
	 displayed. Click the Finish button.
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8.	 Once you have uninstalled Visual Designer you must locate  
	 the installation files used to install Visual Designer on your  
	 development PC and copy them to a USB Memory stick (scan  
	 first for viruses and other malware). If you cannot locate the  
	 installation files you can re-download them from the Eaton  
	 website at www.eaton.com/oi then go to the OI Software  
	 section, and click on the Visual Designer Software under the  
	 Software Downloads section. After the download is complete  
	 you can then unzip the installation files to your memory stick.

9.	 Insert the memory stick into one of the XP’s USB ports and open  
	 the folder to view the files and browse to the Disk1 directory and  
	 double-click on the Setup.exe icon

Launch Setup.exe

10.	Once the installation begins you will be prompted to select the  
	 language to use for installing the software where the default is  
	 English (United States). Select the language and click OK.

11.	Next, you may be prompted to install any prerequisite  
	 software components that are not as yet installed on the  
	 XP unit. If prompted, click on the Install button.

12.	Once the prerequisite components have installed completely  
	 you’ll come to the Installation Welcome Screen. Click Next>.   
	 Note: On smaller XP screens, like the 8” and 10” models, the  
	 resolution of 800x600 is too small to show the entire dialog and  
	 the Next> button may be difficult to click without a mouse. You  
	 can grab the lower part of the title bar and move the window to  
	 the top of the screen in order to cleanly click on the buttons.  
	 For this reason it is recommended to connect a mouse to the  
	 XP unit during this software installation process.

13.	Next you’ll be presented with the License Agreement Screen.   
	 Once you’ve read the license you should click on the Yes button  
	 to agree to the license and proceed.

License Agreement screen

14.	On the Customer Information screen you can modify the User  
	 Name and Company Name properties then click Next>

15.	On the Choose Destination Location dialog it is recommended  
	 to go with the default location of C:\Program Files\Eaton\Visual  
	 Designer vX.X. Click Next>.

16.	On the Select Features dialog, uncheck the optional installation  
	 components as shown below (Demos, Symbol Library, Runtime  
	 for Windows Embedded Compact, Runtime for Windows  
	 Embedded Standard, Windows Mobile, Collaboration Tools)  
	 then click Next>.

Select Features screen

17.	On the next dialog, click Install to begin the installation process.

18.	After the “Installation Wizard Complete” dialog is displayed.  
	 Click Finish to close the dialog.

19.	After the Visual Designer software has been updated you will  
	 need to update the shortcuts in the Start Menu. To do this  
	 you should open Windows Explorer Start > All Programs >  
	 Windows Explorer.

20.	Open the folder C:\Documents and Settings\All Users\Start  
	 Menu\Programs\Eaton\Visual Designer vX.X and select both  
	 Remote Agent and Startup shortcuts and copy them to the  
	 Windows clipboard as shown in the figure below.

Copy Shortcuts from Visual Designer folder in Start Menu
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21.	Next select the Startup folder under the same C:\Documents  
	 and Settings\All Users\Start Menu\Programs folder and paste  
	 the two shortcuts there. You will get confirmation dialog boxes  
	 indicating that you’re replacing the versions that are already in  
	 that folder. Confirm by clicking Yes to All.

22.	Now you need to re-Enable Protect Mode on the XP unit.  
	 To enable Protect Mode open XP’s Protect Mode Manager  
	 Start > All Programs > Protect Mode Manager (top of the list).  
	 In the Protect Mode Manager window click the Advanced tab  
	 and click on the button labeled Enable Protect Mode. This will  
	 cause the XP unit to reboot. Once it reboots Protect Mode is  
	 once again active protecting the operating system from unwanted  
	 change, malware, or sudden power loss and the XP unit’s Visual  
	 Designer software version matches that of the development PC.

Web Server Setup
The XP-702 has Internet Information Services installed and set up 
to support Visual Designer’s built-in web serving feature. The Visual 
Designer factory installed license allows for 1 simultaneous web 
client connection but may be field-upgraded on the XP-702 to allow 
for up to 256 simultaneous web client connections. The IIS settings 
point to the D:\Cfg\APPL\Web folder as the default web location 
so that if the user loads their project to the D:\Cfg\APPL folder, the 
projects web pages will all be placed in the Web subfolder so that 
no changes are required to the IIS settings for the web serving  
feature to work. 

Changing the Default Web Folder for IIS

If for some reason the user wishes to place their Visual Designer 
application folder in a different location then they must take the  
following steps to relocate the default web folder on the XP.

1.	 Open Control Panel and then open Administrative Tools

2.	 From the Administrative Tools folder open Internet  
	 Information Services

3.	 Expand the Local Computer folder then expand the Web  
	 Sites folder

4.	 Right-click on the Default Web Site and choose Properties

5.	 From the Default Web Site Properties dialog select the Home  
	 Directory tab

6.	 Change the Local Path property by clicking the “Browse …”  
	 button and navigate to and select the Web folder under your  
	 desired Visual Designer Project folder, then click the “OK” button.

7.	 Verify that the correct path is now shown in the Local Path  
	 property then click the “OK” button to close the default Web Site  
	 Properties dialog.

8.	 Close all remaining windows and perform a Protect Mode  
	 Save operation.

Connecting to the Visual Designer Web Server from a PC

In order to view the Visual Designer web pages over a network  
connection from a PC, you need to know three things:

1.	 The IP address of the XP running Visual Designer, 

2.	 The name of Visual Designer’s startup screen

3.	 A user name and password configured in the security settings  
	 of Visual Designer.

You can then open Microsoft Internet Explorer and in the address 
bar type in the address of the XP followed by a forward slash, fol-
lowed by the name of the startup screen with a .html extension. For 
example, if the XP is at IP address 192.168.1.20 and the startup page 
of the running project is named “Startup” then the following would 
be the address line to get to the XP’s starting web page:

http://192.168.1.20/Startup.html

The following steps take place when it attempts to display the 
startup web page:

1.	 The startup web page HTML code is sent to the Internet  
	 Explorer browser

2.	 In the header of the code the browser is notified that it  
	 needs a specific version of an OCX (ActiveX) control, named  
	 ISSymbol.ocx, installed and if it is not installed or if it is installed  
	 but is an older version than is required, Internet Explorer is  
	 directed to the Eaton web site to automatically install the  
	 ActiveX control.

3.	 If the user is simultaneously on the Internet and connected to  
	 the XP, and depending on IE’s security settings it will prompt  
	 the user to right click on the browser header to allow blocked  
	 ActiveX content. If the user does so it will download the ActiveX  
	 control and install it.

4.	 Once the correct version of the ActiveX control is installed the  
	 user will be asked to enter their User Name and Password  
	 configured in the Visual Designer security settings. If no security  
	 has been set up in Visual Designer the user named “Guest” with  
	 no password will suffice to open the web startup screen.

Manually Installing the Web Client ActiveX Control

If the PC trying to connect to the web server has Visual Designer 
installed then the ISSymbol.ocx is already installed. However in most 
cases Visual Designer will not be installed on the web client’s PC. If 
the user is not connected to the web when first attempting to con-
nect to the Visual Designer web server Internet Explorer will not be 
able to show the web page. In this case the user will have to manu-
ally install the ActiveX control to their PC. 

Note:N A bug in Visual Designer 7.0 installed an older version of the OCX 
control than is called for by the V7.0 web server. This is fixed in V7.0 Service 
Pack 1 but if you have V7.0 without the fix then the correct version of the 
OCX control will be installed from the Eaton website when you first try to 
connect to the web server, provided you are also connected to the Internet. 
If not connected to the Internet you will also need to manually install the 
ActiveX control.

To install the ActiveX control, follow these steps:

1.	 Connect to the Internet and go to the Eaton Electrical web  
	 site’s Operator Interface product section with the link  
	 www.eaton.com/oi  

2.	 Select the link for Operator Interface Software

3.	 In the Software Downloads area click on the Visual Designer  
	 Software link.

4.	 After providing your e-mail address you will be redirected to the  
	 Documentation Results screen where you can download the  
	 current Visual Designer Symbol Library (ISSymbolVM.cab).

5.	 After downloading the cab file you should be able to open it with  
	 any zip file utility and extract the entire CAB file contents to a  
	 temporary folder on your PC.

6.	 Run the Setup.exe file from the temporary folder, following the  
	 prompts to install it in the default location and to install all  
	 components when prompted. 

7.	 After installation is complete click the “Finish” button.

You will then be able to connect to the Visual Designer web server 
from your PC’s Internet Explorer application.
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Using the XP-702 to Serve the Web Client ActiveX Control

In some applications a remote user will not be able to be connected 
to the Internet and connected to the XP-702 simultaneously. Rather 
than force every remote user to manually install the web client 
ActiveX control it may be preferable to store the ISSymbolVM.cab 
file on the XP and have the ActiveX control automatically installed 
from the XP rather than from the Eaton Electrical web site. To set 
the XP to automatically serve the ActiveX control for first time 
PC’s thin client, download the ISSymbolVM.cab file from the Eaton 
Electrical website as discussed in steps 1-4 from the previous  
section on “Manually Installing the Web Client ActiveX Control”  
and then take the following steps.

1.	 Copy the ISSymbolVM.cab file to the XP’s default web folder.

2.	 Open up the Visual Designer application on your development  
	 PC and go to the Project tab of the Ribbon and click on the Thin  
	 Client icon in the Web group.

3.	 In the Project Settings dialog web section click on the  
	 “Advanced…” button.

4.	 In the Advanced dialog change the ISSymbol URL property to  
	 point to the IP address of the target XP-702. For example, if the  
	 XP’s IP address is set to 192.168.1.20, set the ISSymbol URL  
	 property to: http://192.168.1.20/. Once the correct URL is entered,  
	 click on “OK”

5.	 Click on the round Visual Designer icon in the upper left corner  
	 of the development window and choose Publish (or from the  
	 Publish sub-menu Save All as HTML)

6.	 After all screens have been published, connect to the XP and  
	 download the project as described in the section “Downloading  
	 to the XP-702 via Ethernet”.

Managing Accounts and Changing  
Passwords
There is an account set up on your Eaton XP-702 unit when it was 
shipped from the factory; the Administrator account. The password 
for the Administrator account is Administrator. 

Note:

•	 XP-702 passwords are case sensitive. 
•	 XP-702 account names are not case sensitive.

The XP-702 is set up to automatically log in to the Administrator 
account, which is why the normal Windows XP Security dialog box 
does not appear upon boot-up. 

If you are connecting your Eaton XP-702 unit to a larger network, 
you might want to modify the Administrator account name and 
password to protect the XP-702 unit from unauthorized access. 

Modifying an Account Name and Password 

You can modify the Administrator and any other account name 
password from the User Accounts utility in Control Panel. 

Once the Administrator password has been successfully modi-
fied you must follow the How to Disable/Change the Auto Logon 
Feature section in order to continue to automatically log in to the 
Administrator account at boot-up. 

Note:N All changes made to the C:\ partition must be saved or committed 
so that the next time the XP-702 is restarted the new data will be available. 
Refer to the “Protect Mode Save Operation” section for additional informa-
tion about saving files to the C:\ partition.

Using the Auto Logon Feature 

The XP-702 Auto Logon feature is used to automatically log into a 
specified account name and password. By default, the Auto Logon 
feature is enabled and logs into the Administrator account, using 
Administrator as the account name and password. 

If you want to change the Auto Logon features, refer to the  
descriptions below. 

Note:N You must have Administrative privileges in order to disable/change  
the Auto Logon feature. 

How to Disable/Change the Auto Logon Feature 

To disable or change the Windows XP Auto Logon feature you will 
need to know how to edit the Windows XP registry using Regedit. 
Extreme care should be exercised when making changes to the 
Windows XP registry. If you are not familiar or comfortable making 
changes to the registry, contact your local system or network  
administrator. 

The following entries in the Windows XP registry can be modified  
to change the account, password, and domain used by the Auto 
Logon Feature: 
•	 \HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\

CurrentVersion\ Winlogon\DefaultUserName
•	 \HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\

CurrentVersion\ Winlogon\DefaultPassword 
•	 \HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\

CurrentVersion\ Winlogon\DefaultDomain 

To enable/disable the Auto Logon Feature, set the following registry 
entry to 1 or 0: 
•	 \HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\

CurrentVersion\ Winlogon\AutoAdminLogin 

How to Bypass the Auto Logon Feature 

If you need to switch the logon user back to the Administrator 
account, you may bypass the Auto Logon feature by connecting a 
keyboard to your XP-702 and pressing the right Shift key while boot-
ing up. The Windows XP Security login dialog box appears, which 
allows you to enter a different account name and password. 

Visual Designer’s Remote Agent Utility
Visual Designer’s Remote Agent utility is set to automatically start 
when the XP-702 starts. This utility is the connection that the devel-
opment software uses for uploading, downloading, and online edit-
ing of the Visual Designer project. If for some reason you are unable 
to Connect to the XP-702 from the development software make 
sure that the Remote Agent has not been closed by the local XP 
user. There are only three buttons on the Remote Agent. The “Start” 
button will start the Visual Designer application or restart one that 
was closed. The “Setup” button allows the user to switch from the 
default TCP/IP connection to a Serial Port connection for connection 
to the development PC. The last button “Exit” will bring up a prompt 
box asking if you are sure you want to exit the Remote Agent utility, 
with “Yes” and “No” response buttons.

Normally the user would not change the default behavior of the 
Remote Agent utility as it supports remote features that simplify 
the development process. However, if you wish to disable the auto-
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matic launch of the Remote Agent to prevent remote management 
you can delete the Remote Agent shortcut from the Windows Start 
Menu, Startup folder. 

How to Remove the Remote Agent Auto Startup

To delete the Remote Agent shortcut from the Windows Start Menu 
follow these steps:

1.	 On the XP-702, Open Windows Explorer, Start > All Programs >  
	 Windows Explorer

2.	 Browse to the folder “C:\Documents and Settings\All Users\Start  
	 Menu\Programs\Startup” and delete the Remote Agent shortcut  
	 icon (right-click > Delete) 

3.	 Close the Windows Explorer window and perform a Protect  
	 Mode Save operation. Start > All Programs > Protect Mode  
	 Manager then select the Protect Mode Save tab and click the  
	 “Commit” button.

After the XP saves the changes to Windows partition it will reboot, 
and no longer automatically start the Remote Agent.

The XP-702 FTP Server Setup
The XP-702 is set up to provide FTP server services. The default 
FTP site is named Cfg and its path is D:\Cfg. To connect to the 
FTP site from a PC over Ethernet you must know the IP Address 
of the XP and a valid user name and password. The user name 
Administer and password Administrator are configured by default. 
If, for example, the XP’s IP Address were 192.168.1.20 you would 
open Windows Explorer on your PC and type in the following in the 
address bar:

ftp://192.168.1.20/Cfg

The following Log On dialog will display:

Type in the correct user name and password (Note: the user name 
is not case sensitive but the password is case sensitive) and click  
on the “Log On” button. If the name and password are entered  
correctly you will be able to view the contents of the D:\ drive on  
the XP unit as well as copy and paste files to and from any folder  
on that drive. Note:  You may need to disable the Windows Firewall 
in Control Panel for the FTP connection to work.

How to Create Additional FTP Sites on the XP

It may be useful to allow remote FTP access to other areas of the 
XP. As an example, perhaps you wish to be able to view all files 
on the C:\ drive through the FTP server connection. To do this you 
would take the following these steps:

1.	 Open Control Panel then open Administrative Tools

2.	 Double-click on the Internet Information Services shortcut

3.	 Expand the Local Computer folder then expand the FTP Sites  
	 folder and select the Default FTP Site.

4.	 With the Default FTP Site highlighted, from the toolbar click  
	 on Action>New>Virtual Directory…, which launches the Virtual  
	 Directory Creation Wizard

5.	 Click “Next” on the opening dialog.

6.	 On the “Virtual Directory Alias” dialog enter the name you wish  
	 to call your new FTP site, Eg. “C-Drive”, then click “Next”

7.	 On the “FTP Site Content Directory” dialog click on the  
	 “Browse…” button to browse to the desired folder,  
	 Eg. “System(C:)”, then click “OK”

8.	 Verify that the correct path shows in the Path property, then  
	 click “Next”

9.	 In the “Access Permissions” dialog choose if you want to allow  
	 both Read and Write access, then click “Next” (Note: Since  
	 the C drive is protected by the Protect Mode feature, allowing  
	 write access will not change anything permanently unless a  
	 Protect Mode Save operation is initiated after the write operation)

10.	Click the “Finish” button to close the wizard.

11.	Close all open windows and perform a Protect Mode Save  
	 operation to make these changes permanent.

After the system reboots users with valid password access will  
now be able to access the additional FTP sites.
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